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What to Check First

Check the version of VersaWorks installed on your PC and refer to the instruction manual that matches 
your specifications.

VersaWorks LOGO Manual

This document

 VersaWorks 6

https://webmanual.rolanddg.com/VersaWorks6

Target Models : LEC-330/540,LEJ-640,LEF-12i/200/300



Thank you very much for purchasing this product.

• To ensure correct and safe usage with a full understanding of this product's performance, please be sure 
to read through this manual completely and store it in a safe location.

•  Unauthorized copying or transferal, in whole or in part, of this manual is prohibited.
•  The specifications of this product and the contents of this manual are subject to change without notice.
•  The manual and the product have been prepared and tested as much as possible. If you find any misprints 

or errors, please inform us.
•  Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage that may occur 

through use of this product, regardless of any failure to perform on the part of this product.
•  Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage that may occur with 

respect to any article made using this product.
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What This Document Assumes and Related Manuals

What This Document Assumes
• This guide is for use with both Roland VersaWorks and Roland VersaWorks Dual.

• “Roland VersaWorks” and “Roland VersaWorks Dual” are both written as “VersaWorks” in this guide.

• Before performing any operations described in this guide, make sure that all the following preparations 
are complete.

 ¾Hardware setup, such as the assembly and installation of the printer.

 ¾ Software setup, such as installing VersaWorks on your computer and connecting the computer to 
the printer.

 ¾ Learning the operation of the printer (Refer to the manual included with the printer for more on the 
operation of the printer.)

• This guide is for use with the following printers. Ignore parts of this manual regarding inks not being used.

 ¾Printers equipped with white ink, gloss ink, and primer

 ¾Printers equipped with white ink and gloss ink

 ¾Printers equipped with white ink and primer

 ¾Printers equipped with white ink

 ¾Printers equipped with gloss ink

 Related Manuals
Refer to the following manuals for information on basic and advanced VersaWorks operations.

Help

This manual is included with the software. Information on all software functions, from instructions for basic 
usage of software to detailed instructions for settings, is provided in this guide.
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Features of and Printing Methods for Special Color Inks

Features of Special Color Inks

White

The special white ink used in this printer achieves high density and concealment, and is capable of providing 
attractive results even when white and CMYK colors are overprinted. This ink is suited to printing on transpar-
ent media, and can be used it to create items for shop interiors and displays, PET bottles and other packages, 
decals, and more.

Gloss

The special gloss ink used in this printer is colorless and transparent, and can impart a glossy feel to the printed 
item, as well as enhance weatherability and robustness※. Also, depending on the printing settings, you can 
even deliberately eliminate glossiness and produce a matte finish, or perform fill overprinting using gloss ink 
to raise the printed surface and create an embossed finish.

* Glossiness, weatherability, and robustness may vary depending on the media used, the environment, 
and other printing conditions.

Primer

The primer is a colorless and transparent coating agent used as an ink base. By using the primer as a base, you 
can print on glass or other materials on which UV ink cannot be applied.

* The primer may not be fully efficient on some materials. Be sure to perform test printing to check the 
effect.

Printing Method Using White Ink

Printing White Only

You can also perform printing using white ink only. To display the side opposite the printed surface, you can 
take such action as printing a mirror image of the artwork.

 " P. 18, "Printing Only with White Ink"

Printing using white and CMYK ink

Print the area using white ink and the area using CMYK color inks simultaneously, in a single pass. Printing 
the areas simultaneously eliminates displacement during media feed, making stable, highly intricate printing 
possible. When you're printing on a transparent film, you can create results intended to be viewed from the 
back (the side opposite the printed surface) by reversing the image or changing the sequence in which white 
and CMYK colors are printed.

 " P. 20, "Printing with White and CMYK Colors in a Single Pass"
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Printing Method Using Gloss Ink

Gloss-finish Printing

This printing method imparts a glossy finish to the printed item. Forming a coating of gloss ink imparts a glossy 
finish and can also achieve high weatherability and robustness.
The output printed using white or CMYK color inks is pulled back once and then is overprinted with gloss ink.

 " P. 24, "Gloss-finish Printing (White or CMYK Colors > Gloss)"
Printing using only gloss ink is also possible.

 " P. 39, "Printing Only with Gloss Ink"

Matte-finish Printing

This printing method eliminates glossiness and produces a restful matte finish. This perform fill overprinting 
of white and CMYK colors with gloss ink, which makes it possible to produce results where glossiness is sup-
pressed while weatherability and robustness are enhanced.
When white ink is used, the output printed using white or CMYK color inks is pulled back once and then is 
overprinted with gloss ink.

 " P. 27, "Matte-finish Printing (White or CMYK Colors > Gloss)"
When white ink is not used, printing can be done with CMYK color inks and gloss ink simultaneously without 
the pulling back process.

 " P. 30, "Matte-finish Printing (Single-pass Printing Using CMYK Color and Gloss Inks)"
Printing using only gloss ink is also possible.

 " P. 39, "Printing Only with Gloss Ink"

Embossed-finish Printing

This printing method can produce items that have a three-dimensional feel by performing fill overprinting 
of the item using gloss ink. You determine the height to which the printed surface is raised by setting the 
number of fill-overprint passes in VersaWorks. After performing fill-overprinting by this specified number of 
passes, the item is overprinted one last time using gloss ink to produce a gloss finish.
The output printed using white or CMYK color inks is pulled back once and then is overprinted with gloss ink.

 " P. 32, "Embossed-finish Printing (White or CMYK Colors > Gloss)"
Printing using only gloss ink is also possible.

 " P. 39, "Printing Only with Gloss Ink"

Printing Method Using Primer

Printing with Primer Only

Perform printing by using primer only. After that, perform printing by using other colors.
 " P. 42, "Printing Only with Primer"

Printing with Primer and Other Inks Simultaneously

Perform printing by using primer and other colors simultaneously while using the primer as a base.
 " P. 44, "Printing with Primer and CMYK Colors or White in a Single Pass"
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Important Points to Know Before Performing Operations

Important: Characteristics of Inks and Important Notes
The usage and handling of white ink involves some important considerations that do not apply to ink of other 
colors. Be sure to familiarize yourself with the characteristics of the inks before you use them.

White ink settles and separates.

If they are allowed to stand, the precipitates in the inks may solidify and cause clogging of the print heads or 
other malfunctions. Be sure to observe the cautions in this manual.

Maintenance Must be Performed.

• Always keep the main power switched on. If the main power is switched off, the automatic maintenance 
function stops working, and may result in malfunction.

• We recommend operating the printer at least once a week.

• If the printer is left unused for a long period of time, ink precipitation may occur, causing unstable ink 
discharge, which may result in dot drop-out, etc. In such cases, the precipitated and solidified ink needs 
to be discharged. Refer to the user's manual of the printer you are using to implement proper cleaning.

• If cleaning fails to resolve issues such as dot drop-out, contact your authorized Roland DG Corp. dealer.

Important Notes in Using Transparent Media
* The following is not applicable to the LEF Series.

Loading Transparent Media

• Set the [EDGE DETECTION] menu item to “DISABLE.” Transparent media cannot be loaded unless this 
setting is made.

• Ensure a margin of at least 75 mm (2.95 in.) from the leading edge of the media to the printing- or cut-
ting-start location.

Important Notes on the Amount of Media Remaining

• When you use transparent media, the presence of media cannot be detected. In such cases, printing 
operation does not stop when the media runs out, and there is a chance that the platen or the like may 
become soiled by ink or that ink may get inside and damage the machine.

• If media runs out while printing is in progress, immediately stop printing.

Using the Middle Pinch Rollers

The middle pinch rollers will leave slight traces of pressing on the media, and on transparent media this damage 
can be very noticeable. Also, the middle pinch rollers will smudge the printed surface when transparent media 
is pulled back after printing. When using transparent media, secure the media in place using only two pinch 
rollers on the right and the left. However, some types of media may float partially, causing adverse effects on 
printing, feeding, and/ or cutting. Check the media before use.

Automatic Crop-Mark Detection

Automatic crop-mark detection may not be possible for some media, such as transparent media. In such cases, 
perform alignment manually.
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Degreasing the Print Surface
When primer is used, degreasing the print surface before printing is effective to improve ink adhesion. For inks 
other than primer, degreasing the print surface before printing may also be effective to improve ink adhesion.
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Basic Approach for Creating Printing Data

Using a Spot Color for Special Colors

Select a spot color for special colors from the exclusive swatch library and apply the spot color on the printing 
data.

• White: RDG_WHITE

• Gloss: RDG_GLOSS

• Primer: RDG_PRIMER (Usable with VersaWorks Dual only)
 " P. 9, "Creating Printing Data Using a Spot Color for Special Colors"

Generating Special Color Plates with VersaWorks Dual

Even with printing data in which a spot color for special colors is not used (printing data in which only CMYK 
colors is used), you can use the function of VersaWorks Dual to generate special color plates (white, gloss, 
and primer).

* This function is available with VersaWoks Dual only. It cannot be used with VersaWoks.
 " P. 58, "Generating Special Color Plates"

Creating Printing Data Using a Spot Color for Special Colors
Create the data for printing using the white ink or gloss ink.
The description in this section uses Adobe Illustrator CS6. For detailed information on drawing methods and 
how to work with palettes, refer to the documentation or online help for Adobe Illustrator CS6. If you are 
using another version of Adobe Illustrator, operations may be somewhat different from those explained here.

1. Open the exclusive swatch library and color library.

A Open the dialog box to use in selecting the library.
1 Open the swatch palette menu.

The swatch palette is displayed by going to the menu and selecting [Window], then [Swatches].
2 Click [Open Swatch Library].
3 Click [Other Library].

The "Open" (or "Select Library") dialog box appears.

 Creating Printing Data
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B Open the exclusive swatch library.
1 Open the folders in the order of [Computer] → [OS (C:)] → [Program Files] ([Program 

Files (x86)] for 64-bit OS) → [Roland VersaWorks] (or [Roland VersaWorks Dual]) → 
[Swatch] → [Illustrator].

2 Select “Roland VersaWorks.ai.”
Depending on the settings of your computer, the extension “.ai” might not be shown.

3 Click [Open].
The swatch library containing “RDG_WHITE,” “RDG_GLOSS,” and “RDG_PRIMER” is displayed.

MEMO

By saving the “.ai” file selected in step B into the folder below, you can register each swatch library to the 
Adobe Illustrator library. Once the registration is performed, you can open the library directly from the swatch 
palette menu, eliminating the need to search the file every time you start Adobe Illustrator.
C: \Program Files\Adobe\Adobe Illustrator CS6\Presets\(language abbreviation)\Swatches
* "C" is the name of your computer's local disk.
* For 64-bit OS, select [Program Files (x86)] instead of [Program Files].
* The language abbreviation differs depending on the language used.
* Depending on the version of Illustrator used, “\Preset\Swatch” may be used instead of “\Presets\(lan-

guage abbreviation)\Swatch.”
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2. Create the illustration, and specify the spot color that matches the color you want to print.

A Create the illustration.
Be sure to draw the illustration in the CMYK mode.

B Specify each spot color that matches the color you want to print.

Desired ink or color Spot color name
White ink RDG_WHITE

Gloss ink RDG_GLOSS

Primer RDG_PRIMER

* “RDG_PRIMER” is usable with VersaWorks Dual only.

Specify “RDG_WHITE” for 
the areas where you want to 
use white ink.

Specify "RDG_GLOSS" for the ar-
eas where you want to use gloss ink.

Specify "RDG_PRIMER" for 
the areas where you want to 
use primer.
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3.  Create the PS (PostScript) file.

* When using VersaWorks Dual, saving the file as a PDF file rather than a PS file is recommended.

A Select [Roland VWD] or [Roland VW].
1 Select [Print] from the [File] menu.
2 Select [Roland VW].

When a nickname is set, or when more than one printer is connected, select “Roland VW_(the nickname 
of the printer used for output).”

3 Click [Setup].

4 Click [Continue].



1

Getting Ready
 Creating Printing Data

13

B Set the page size of the output data.
1 Turn on the [Print to file] option.
2 Click [Preferences].
3 Click [Advanced] in the [Layout] tab.

4 Click the down arrow to the right of the [Paper Size] box, and then click [PostScript 
Custom Page Size] from the list that appears.

5 For “Custom Page Size Definition,” enter the values in the “Width” and “Height” fields.
Enter values for the same size as the illustration you created in step 2.

C Click [OK] three times to close the “PostScript Custom Page Size Definition,” “Roland 
VersaWorks Advanced Options,” and “Printing Preferences” dialog boxes.
The “Print” dialog box returns.
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D Output the data as a file.
1 Click [Print].
2 Click [Print].

3 Specify the destination and file name.
Example: "C:/white-gloss_print" for the folder to save to, and "white-gloss_print.ps" as the file name

4 Click [Save].
The image is saved in the specified folder as a PS file.
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Introduction

Before You Start Printing
• Remove just the white ink cartridge, shake it 50 times (about 15 seconds), and then reinsert this 

cartridge.

• The ink cartridges other than white do not need to be shaken before every operation, but be sure 
to shake them when installing new ones.

If ink components precipitate, it will not be possible to print with correct colors. So that the ink mixes well, shake 
the ink cartridge horizontally with a stroke length of around 5 cm (2 in.) from each end of the ink cartridge.
The components in the white ink have a tendency to precipitate. Each day, before starting the day's operations, 
be sure to carry out the above steps. Allowing the ink to stand without carrying out these steps can cause the 
settled material to harden, resulting in malfunction or other problems.

Media
You can select media from different types of paper in order to meet your needs. Before selecting media, be 
sure to perform trial printing to check whether satisfactory output quality is obtained.

Print Modes
Set the print mode based on the type of ink and printing method.

Print mode Color of ink used and printing method Page

White Print only with white ink. P. 18

White -> CMYK 
Print white and CMYK color data in a single pass.
The white ink is overprinted by the CMYK color inks.

P. 20

CMYK -> White
Print white and CMYK color data in a single pass.
The CMYK color inks are overprinted by the white ink.

P. 20

GlossVarnish

Carry out gloss-finish printing using gloss ink.
After performing printing using white and CMYK color 
data, this method pulls back the media, then performs 
fill overprinting using gloss ink.
Printing using only gloss ink is also possible. (*)

P. 24
(*)P. 39

MatteVarnish

Carry out matte-finish printing using gloss ink.
After performing printing using white and CMYK color 
data, this method pulls back the media, then performs 
fill overprinting using gloss ink.
Printing using only gloss ink is also possible. (*)

P. 27
(*)P. 39

CMYK -> MatteVarnish

Carry out matte-finish printing using gloss ink.
Printing of CMYK color data and gloss ink data is per-
formed in a single pass, but the sequence is such that the 
CMYK color inks are overprinted by the gloss ink.

P. 30
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Print mode Color of ink used and printing method Page

Embossing

Carry out embossed-finish printing using gloss ink.
After performing printing using white and CMYK color 
data, this method pulls back the media, then performs 
fill overprinting using gloss ink.
Printing using only gloss ink is also possible. (*)

P. 32
(*)P. 39

Primer1

Print only with primer.
The texture of the finish and ink adhesion are different 
between Primer 1 and Primer 2. You can also perform 
printing using Primer 1 and Primer 2 in turns. Overlaying 
Primer 1 and Primer 2 may result in different effects in 
the texture or adhesion from the case where they are 
used individually for printing. The texture and adhesion 
may vary depending on the media to be used. Select an 
appropriate type according to their properties.

P. 42

Primer2

Primer -> CMYK
Print primer and CMYK color data in a single pass.
The primer is overprinted by the CMYK color inks.

P. 44

Primer -> White
Print primer and white data in a single pass.
The primer is overprinted by the white ink.

P. 44
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Printing Only with White Ink
This section describes how to perform printing only with the white ink.

Procedure

A Create data for printing.
 " P. 9, "Creating Printing Data"

B Double-click .
The “Queue A Properties” window appears.

C Select the media type, print quality, and print mode.
1 Click .

2 Select a [Media Type].

Generic This is the basic setting when white ink is used.

Generic High-
opacity White

This outputs white of higher opacity than "Generic." Depending on the ink 
type of your printer, this option may be disabled.

Generic Distance This can be selected when you use the LEF-12i, LEF-200, or LEF-300. This 
setting is suitable when you print on media whose print surface is uneven.

Printing Using White Ink
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3 Select a [Print Quality].
* The items displayed for [Print Quality] will vary depending on the [Media Type] selected in step 2.
4 For [Mode], select [White].
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”

D Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.
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MEMO: When you want to display the side opposite the printed surface by using clear film

1 Click .

2 Turn on the [Mirror] option.
When the printing data with mirror image is prepared beforehand, you do not need to turn on this 
option.

E Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
* Only the settings necessary for the use of the white ink are described in this section. For other settings, 

refer to the online help provided for VersaWorks.

Printing with White and CMYK Colors in a Single Pass
This section describes how to perform printing with white ink and CMYK color inks. Deciding which ink between 
white and CMYK you want to use for the base is an important point in determining the print job settings here.

Procedure

A Create data for printing.
 " P. 9, "Creating Printing Data"

B Double-click .
The “Queue A Properties” window appears.
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C Select the media type, print quality, and print mode.
1 Click .

2 Select a [Media Type].

Generic This is the basic setting when white ink is used.

Generic High-
opacity White

This outputs white of higher opacity than "Generic." Depending on the ink 
type of your printer, this option may be disabled.

Generic Distance This can be selected when you use the LEF-12i, LEF-200, or LEF-300. This 
setting is suitable when you print on media whose print surface is uneven.

3 Select a [Print Quality].
* The items displayed for [Print Quality] will vary depending on the [Media Type] selected in step 2.
4 For [Mode], select the print mode.

White -> CMYK Inks are overprinted in the sequence of white and then CMYK.

CMYK -> White Inks are overprinted in the sequence of CMYK and then white.

* These modes may be disabled depending on the print quality selected in step 3.
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”
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Image of overprinting in the sequence of white and then CMYK

You will have the printed image 
from this side (the printed surface 
of the finished results).

Transparent film

White
CMYK

* The white data and the CMYK color data are actually printed simultaneously, but they are shown here 
as separate layers in order to indicate the printing sequence.

Image of overprinting in the sequence of CMYK and then white

Transparent film

You will have the printed image 
from this side (the opposite side of 
the printed surface of the finished 
results).

White
CMYK

* The white data and the CMYK color data are actually printed simultaneously, but they are shown here 
as separate layers in order to indicate the printing sequence.

D Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .
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2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

MEMO

See P. 20, "MEMO: When you want to display the side opposite the printed surface by using clear film" when 
you want to display the side opposite the printed surface by using clear film.

E Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
* Only the settings necessary for the use of the white ink are described in this section. For other settings, 

refer to the online help provided for VersaWorks. 
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Printing Using Gloss Ink

Gloss-finish Printing (White or CMYK Colors > Gloss)
This section describes the printing method that produces a glossy finish on the printed item. After performing 
printing using white and CMYK color data, this method pulls back the media, then performs fill overprinting 
using gloss ink. This means that the setting must be made to pull back the media after printing the white and 
CMYK color data.

* For the LEF series, there is no need to make the setting to pull back the media after printing.

Procedure

A Make the setting to pull back the media after printing, then perform printing of the white 
or CMYK color data.

* For the LEF series, there is no need to make the setting to pull back the media after printing.
For the printing method using white ink, refer to P. 18, "Printing Using White Ink".
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn on the [Return to Origin After Print] option.

When the LEF series is used:

After the printing finishes, the screen below is displayed. Do not change the media and press [ENTER] 
on the operation panel of the printer to proceed to step B.

FINISHED PRINT



Printing Using Gloss Ink

2

Printing

25

B Double-click a printing job to open the "Job Setting" window.

C Select the media type, print quality, and print mode.
1 Click .

2 For [Media Type], select [Special Effects].
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3 Select a [Print Quality].
4 For [Mode], select [GlossVarnish].
* This mode may be disabled depending on the print quality selected in step 3.
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”

D Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

E Click [OK] to close the “Queue A Properties” window.
This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".

* Only the settings necessary for the use of the gloss ink and white ink are described in this section. For 
other settings, refer to the online help provided for VersaWorks.
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Matte-finish Printing (White or CMYK Colors > Gloss)
This section describes the printing method that produces a matte finish on the printed item. After performing 
printing using white and CMYK color data, this method pulls back the media, then performs fill overprinting 
using gloss ink. This means that the setting must be made to pull back the media after printing the white and 
CMYK color data.

* For the LEF series, there is no need to make the setting to pull back the media after printing.

Procedure

A Make the setting to pull back the media after printing, then perform printing of the white 
or CMYK color data.

* For the LEF series, there is no need to make the setting to pull back the media after printing.
For the printing method using white ink, refer to P. 18, "Printing Using White Ink".
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn on the [Return to Origin After Print] option.

When the LEF series is used:

After the printing finishes, the screen below is displayed. Do not change the media and press [ENTER] 
on the operation panel of the printer to proceed to step B.

FINISHED PRINT
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B Double-click a printing job to open the "Job Setting" window.

C Select the media type, print quality, and print mode.
1 Click .

2 For [Media Type], select [Special Effects].
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3 Select a [Print Quality].
4 For [Mode], select [MatteVarnish].
* This mode may be disabled depending on the print quality selected in step 3.
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”

D Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

E Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
* Only the settings necessary for the use of the gloss ink and white ink are described in this section. For 

other settings, refer to the online help provided for VersaWorks.
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Matte-finish Printing (Single-pass Printing Using CMYK Color and Gloss Inks)
This section describes the printing method that produces a matte finish on the printed item through single-
pass printing using CMYK color and gloss inks. Single-pass printing of the CMYK color and gloss ink is enabled 
only for the matte-finish printing.

Procedure

A Create data for printing.
 " P. 9, "Creating Printing Data"

B Double-click .
The “Queue A Properties” window appears.

C Select the media type, print quality, and print mode.
1 Click .

2 Select a [Media Type].

Generic with Special 
Effects

This is the basic setting for the matte-finish printing through single-pass 
printing using CMYK color and gloss inks.

Generic Distance with 
Special Effects

This can be selected when you use the LEF-12i, LEF-200, or LEF-300. 
This setting is suitable when you print on media whose print surface 
is uneven.
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3 Select a [Print Quality].
* The items displayed for [Print Quality] will vary depending on the [Media Type] selected in step 2.
4 For [Mode], select [CMYK -> MatteVarnish].
* This mode may be disabled depending on the print quality selected in step 3.
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”

D Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

E Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
* Only the settings necessary for the use of the gloss ink are described in this section. For other settings, 

refer to the online help provided for VersaWorks.
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Embossed-finish Printing (White or CMYK Colors > Gloss)
This section describes the printing method that produces an embossed finish by raising the printed surface 
through fill overprinting using gloss ink. After performing printing using white and CMYK color data, this 
method pulls back the media, then performs fill overprinting using gloss ink. This means that the setting must 
be made to pull back the media after printing the white and CMYK color data.

* For the LEF series, there is no need to make the setting to pull back the media after printing.
You use VersaWorks to set the number of fill-overprinting passes using gloss ink. The unit performs matte-
finish fill overprinting for the specified number of passes, then performs overprinting one additional time to 
give the surface a glossy finish. This means that the number of fill-overprint passes using gloss ink is equal to 
the number set using VersaWorks plus one.

Procedure

A Make the setting to pull back the media after printing, then perform printing of the white 
or CMYK color data.

* For the LEF series, there is no need to make the setting to pull back the media after printing.
For the printing method using white ink, refer to P. 18, "Printing Using White Ink".
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn on the [Return to Origin After Print] option.

When the LEF series is used:

After the printing finishes, the screen below is displayed. Do not change the media and press [ENTER] 
on the operation panel of the printer to proceed to step B.

FINISHED PRINT
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B Double-click a printing job to open the "Job Setting" window.

C Select the media type, print quality, and print mode.
1 Click .

2 For [Media Type], select [Special Effects].



Printing Using Gloss Ink

2

Printing

34

3 Select a [Print Quality].
4 For [Mode], select [Embossing].
* This mode may be disabled depending on the print quality selected in step 3.
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”

D Set the number of overprinting passes.
1 Click .

2 Select the [Use Custom Settings] check box.
3 Set the number of overprinting passes.

The number of overprint passes for an embossed finish is the specified number of passes plus one. 
For more information, refer to P. 36, "Specified number of overprinting passes for an embossed 
finish and ink thickness".

E Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .
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2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

F Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
* Only the settings necessary for the use of the white ink are described in this section. For other settings, 

refer to the online help provided for VersaWorks.
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Specified number of overprinting passes for an embossed finish and ink thickness

• The number of overprint passes for an embossed finish is the specified number of passes plus one.

• The ink thickness based on the specified number of overprint passes varies according to the type of 
media used and the printing environment.

• If the print heads rub the printed surface or media jams, review the number of overprint passes, the type 
of media, and the head position. However, please note that setting a high head position may result in 
coarse printing.

LEC-330 / 540 or LEJ-640: 
(Inks used: Cyan, magenta, yellow, black, gloss, and white)

0.0

0.4

7531

High Quality

Standard

(passes)

(mm)

(Set using )

Specified number of overprinting passes

Ink thickness
 (thickness of specified num

ber 
of passes +1)

• Media: Uncoated PET film
• Ambient temperature: 25ºC (77ºF)

For reference: Specified number of overprinting passes and ink thickness
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LEC-330 / 540 or LEJ-640:
(Inks used: Cyan, magenta, yellow, black, gloss, and gloss)

0.0

0.8

7531

High Quality

Standard

(passes)

(mm)

(Set using )

Specified number of overprinting passes

Ink thickness
 (thickness of specified num

ber of 
passes +1)

• Media: Uncoated PET film
• Ambient temperature: 25ºC (77ºF)

For reference: Specified number of overprinting passes and ink thickness

LEF-12i / 200:
(Inks used: Cyan, magenta, yellow, black, gloss, and white)

0.0

0.4

107531 (passes)

(mm)

Specified number of overprinting passes

Ink thickness
 (thickness of specified num

ber 
of passes +1)

• Media: Uncoated PET film
• Ambient temperature: 25ºC (77ºF)

For reference: Specified number of overprinting passes and ink thickness
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LEF-300:
(Inks used: Cyan, magenta, yellow, black, gloss, gloss, and white)

0.0

0.4

10 13 157531

0.8

(passes)

(mm)

Specified number of overprinting passes

Ink thickness
 (thickness of specified 
num

ber of passes +1)

• Media: Uncoated PET film
• Ambient temperature: 25ºC (77ºF)

For reference: Specified number of overprinting passes and ink thickness

LEF-300:
(Inks used: Cyan, magenta, yellow, black, gloss, white, and primer)

0.0

0.4

107531 (passes)

(mm)

Specified number of overprinting passes

Ink thickness
 (thickness of specified 
num

ber of passes +1)

• Media: Uncoated PET film
• Ambient temperature: 25ºC (77ºF)

For reference: Specified number of overprinting passes and ink thickness
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Printing Only with Gloss Ink
Gloss finish, matte finish, and embossed finish can also all be printed using only gloss ink.

Procedure

A Create data for printing.
 " P. 9, "Creating Printing Data"

B Double-click .
The “Queue A Properties” window appears.

C Select the media type, print quality, and print mode.
1 Click .

2 For [Media Type], select [Special Effects].
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3 Select a [Print Quality].
4 For [Mode], select the print mode.

GlossVarnish Gloss finish P. 24, "Gloss-finish Printing (White or CMYK Colors > Gloss)"

MatteVarnish Matte finish

P. 27, "Matte-finish Printing (White or CMYK Colors > Gloss)"

P. 30, "Matte-finish Printing (Single-pass Printing Using CMYK Color 

and Gloss Inks)"

Embossing Embossed fin-
ish

P. 32, "Embossed-finish Printing (White or CMYK Colors > Gloss)"

* These modes may be disabled depending on the print quality selected in step 3.
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”

D To use an embossed finish, set the number of overprinting passes.
* This setting is unnecessary for a gloss finish and a matte finish.
1 Click .

2 Select the [Use Custom Settings] check box.
3 Set the number of overprinting passes.
* The number of overprint passes for an embossed finish is the specified number of passes plus 

one. For more information, refer to P. 36, "Specified number of overprinting passes for an 
embossed finish and ink thickness".
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E Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

MEMO

See P. 20, "MEMO: When you want to display the side opposite the printed surface by using clear film" when 
you want to display the side opposite the printed surface by using clear film.

F Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
* Only the settings necessary for the use of the white ink are described in this section. For other settings, 

refer to the online help provided for VersaWorks.
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Printing Using Primer

Printing Only with Primer
* “RDG_PRIMER” is usable with VersaWorks Dual only.

This section describes how to perform printing only with primer.

Procedure

A Create data for printing.
 " P. 9, "Creating Printing Data"

B Double-click .
The “Queue A Properties” window appears.

C Select the media type, print quality, and print mode.
1 Click .

2 For [Media Type], select [Primer].
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3 Select a [Print Quality].
4 For [Mode], select [Primer1] or [Primer2].
* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “10p.”

D Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

MEMO

See P. 20, "MEMO: When you want to display the side opposite the printed surface by using clear film" when 
you want to display the side opposite the printed surface by using clear film.

E Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
* Only the settings necessary for the use of the primer are described in this section. For other settings, 

refer to the online help provided for VersaWorks.
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Printing with Primer and CMYK Colors or White in a Single Pass
* “RDG_PRIMER” is usable with VersaWorks Dual only.

This section describes how to print primer data and CMYK color data, or primer data and white data, in a 
single pass.

Procedure

A Create data for printing.
 " P. 9, "Creating Printing Data"

B Double-click .
The “Queue A Properties” window appears.

C Select the media type, print quality, and print mode.
1 Click .

2 For [Media Type], select [Generic with Primer].
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3 Select a [Print Quality].
4 For [Mode], select the print mode.

Primer -> CMYK The primer is overprinted by the CMYK color inks.

Primer -> White The primer is overprinted by the white ink.

* The items displayed for [Mode] will vary depending on the model used.
* The name for [Mode] may have a suffix such as “(v)” or “HD.”

D Set the printer operation.
* This setting is unnecessary for the LEF series.
1 Click .

2 In [Operation Mode], select “Print Only.”

3 Turn off the [Return to Origin After Print] option.

E Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
*  Only the settings necessary for the use of the primer are described in this section. For other settings, 

refer to the online help provided for VersaWorks. 
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Starting the Print Operation
After configuring the print job settings, you can start the print operation.

Procedure

A Configure the settings for the print job.
 " P. 18, "Printing Using White Ink"
 " P. 24, "Printing Using Gloss Ink"
 " P. 42, "Printing Using Primer"

B Go to “Job List,” click the “Queue A” tab, and drag the printing data to the queue A 
job list. (If the print job setting has been made in [Queue B], drag and drop the printing 
data on the job list of [Queue B].)

The contents of the data are displayed in the preview window, and the layout on the media is displayed in the 
layout window.

• Areas specified to “RDG_WHITE” are displayed with shading in transparent red.

• Areas specified to “RDG_GLOSS” are displayed with shading in transparent blue.

• Areas specified to “RDG_PRIMER” are displayed with shading in transparent green.

Starting the Print Operation
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MEMO

If the areas specified to “RDG_WHITE,” “RDG_GLOSS,” or “RDG_PRIMER” are not displayed with shading, any of 
the settings for [Quality Settings] - [Mode] is incorrect. Check the settings.

C Select the print job in the job list, and then click .
Printing will be started.

MEMO

To continue printing similar data, repeat steps B and C. Also, if you want to modify detailed settings for each 
job, it will be convenient to perform modifications in the “Job Setting” window (displayed by double-clicking 
the print job in the job list).
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What is Texture Printing?
Texture printing is defined as the method of producing texture patterns with gloss ink. This uses the texture 
patterns provided by the exclusive library to create and output print data.

MEMO

* “Matte-finish Printing” is recommended for finishing. Detailed representation is difficult with gloss-finish 
printing and embossed-finish printing.

* To use Adobe Illustrator for creating the printing data, use version CS5 or later. Using a version of Adobe 
Illustrator before CS5 to create the printing data may result in texture patterns that do not print well.

Checking the Pattern of Texture Printing
Print a chart that works as a texture print sample and check the texture patterns. Printing a chart allows you 
to check the texture patterns that can be printed with your printer and your media. By creating print data 
with the texture pattern you select in this chart, you can print your intended pattern almost perfectly. (Slight 
pattern differences may result depending on the printer or media content.)

* To print a chart, use the same media as the one that will actually be used.

Procedure

A Double-click .
The “Queue A Properties” window appears.

* Chart output is possible for Queue A only.

Performing Texture Printing
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Performing Texture Printing

B  Click , and then set the media type, print quality, and print mode.

Select the media type, print quality, and print mode that will actually be used. For details on how 
to configure the settings, refer to the following.
 " P. 27, "Matte-finish Printing (White or CMYK Colors > Gloss)"
 " P. 30, "Matte-finish Printing (Single-pass Printing Using CMYK Color and Gloss Inks)"
 " P. 39, "Printing Only with Gloss Ink"

MEMO

When printing a Texture Chart, the [Quality] settings from the [Queue Properties] window are always applied. 
Because you cannot change the quality settings for the job using the [Job Settings] window after it has been 
added, be sure to configure the settings in the [Queue Properties] window before performing the following 
operations.

C Add the texture chart print job to the job list.
1 Click [Media] and then [Chart].

The following message appears: “The following job will be printed. Do you want to continue?” Check 
whether the media in the printer is large enough for the displayed page size.

2 Click [OK].
The texture chart print job is added to the job list.

3
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Performing Texture Printing

D Click .
The texture chart from “Roland Texture System Library” is printed.

* Use the printed chart to specify the texture pattern in step 2 of P. 52, "Printing Texture Data".

Printing Texture Data
Create printing data for texture printing. The program used to create the printing data is Adobe Illustrator 
CS6 in this section. For detailed information on drawing methods and how to work with palettes, refer to the 
documentation or online help for Adobe Illustrator CS6. If you are using another version of Adobe Illustrator, 
operations may be somewhat different from those explained here.

1. Open the exclusive library.

A Open the dialog box to use in selecting the library.
1 Open the swatch palette menu.

The swatch palette is displayed by going to the menu and selecting [Window], then [Swatches].
2 Click [Open Swatch Library].
3 Click [Other Library].

The "Open" (or "Select Library") dialog box appears.

3
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Performing Texture Printing

B Open the exclusive library.
1 Open the folders in the order of [Computer] → [Local Disk (C:)] → [Program Files] 

or [Program Files (x86)] → [Roland VersaWorks] or [Roland VersaWorks Dual] → 
[Swatch] → [Illustrator], and then select “Roland Texture System Library.ai” and 
“Roland Grapac Bri-o-coat Library.ai.”

* Depending on the settings of your computer, the extension “.ai” might not be shown.
2 Click [Open].

The exclusive texture libraries “Roland Texture System Library” and “Roland Grapac Brio-coat Library” 
are displayed.

When the following screen is displayed, click [Update].

3
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Performing Texture Printing

2. Create the illustration and specify the texture pattern you want to use.

 Create the illustration.
Be sure to draw the illustration in the CMYK mode.

 Specify the texture pattern you want to use for the area of texture printing.
Check the texture pattern in the chart printed in the procedure of P. 50, "Checking the Pattern of 
Texture Printing". Since colors and patterns may be slightly different depending on the media, use 
a chart printed on the same media as the one that will actually be used.
Use gloss ink to print the area where the texture pattern is specified. To use gloss ink for printing 
other than texture printing, use an exclusive spot color “RDG_GLOSS.”
 " P. 9, "Creating Printing Data"

The name of the texture pattern is displayed 
above the data in Illustrator. The texture of the 
displayed image appears rougher than that of 
the actual print.

C Use VersaWorks to make settings for “Matte-finish Printing” and print the data.
 " P. 27, "Matte-finish Printing (White or CMYK Colors > Gloss)"
 " P. 30, "Matte-finish Printing (Single-pass Printing Using CMYK Color and Gloss Inks)"
 " P. 39, "Printing Only with Gloss Ink"

IMPORTANT

“Matte-finish Printing” is recommended for finishing. Detailed representation is difficult with gloss-finish 
printing and embossed-finish printing.

A test pattern is printed.

3
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 Making Printing Settings for Each Job

Procedure

Before printing, double-click the print job list.
The “Job Setting” window appears. This window can be used to configure advanced settings for a 
specific job, including settings that control printer operation and color adjustment.

Double-click a 
printing job.

Description

When outputting numerous jobs consecutively, print settings that vary between jobs can be troublesome. 
Accordingly, the “Job Setting” window is where you configure the settings for individual jobs before printing. 
In other words, with this approach, you configure shared basic settings in the “Queue Properties” window 
and configure the settings for the individual job in the “Job Setting” window. The settings in the “Job Setting” 
window are reflections of the settings made in the “Queue Properties” window, so job-specific settings such 
as color adjustment can be configured.

More Advanced Printing Settings
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More Advanced Printing Settings

Composing CMYK Data and White/Gloss Data with VersaWorks
When you have print data created for CMYK inks and for white (or gloss) ink separately, you can compose them 
in VersaWorks to output it as a single job.
To use this feature, the following requirements must be met.

• The printing-data combination that you can compose is a piece of printing data containing only 
CMYK colors and one containing only white, or a piece of printing data containing only CMYK 
colors and one containing only gloss.

• The printing data is a TIFF file.

• The printing data containing only white or gloss was saved with "Color Mode” of "TIFF Options” 
set to "Grayscale."

* In the explanations in this section, Adobe Illustrator CS6 is the program used to create the printing data.

Procedure

A Prepare a TIFF file containing CMYK colors and a TIFF file containing white (or gloss).

B Double-click .
The “Queue A Properties” window appears.

C Select the option for “Special channel configuration” according to the data to be used 
for printing.
1 Click .

2 Select the option for “Special channel configuration.”
• When using printing data containing white only: Ex1=RDG_WHITE
• When using printing data containing gloss only: Ex1=RDG_GLOSS
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More Advanced Printing Settings

D Set the options to compose the two jobs.
1 Click .
2 Select the [Number of Jobs] check box.
3 Select “2” for [Number of Jobs].
4 Select the [Compose] check box.

5 Click [OK].

E Make the other settings in the “Queue A Properties” window.
* Single-pass printing of the gloss ink and CMYK color inks is enabled only for the matte-finish 

printing.
 " P. 27, "Matte-finish Printing (White or CMYK Colors > Gloss)"
 " P. 30, "Matte-finish Printing (Single-pass Printing Using CMYK Color and Gloss Inks)"

F Start printing.
1 Go to "Job List" and click the "Queue A" tab.
2 Drag the TIFF file containing CMYK colors and TIFF file containing white (or gloss) 

and drop them into the queue A job list.
Composing is performed automatically.

3 Click .
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More Advanced Printing Settings

Generating Special Color Plates
This section describes how to generate special color plates (white, gloss, and primer) in VersaWorks Dual. To 
create special color plates in Illustrator, see P. 9, "Creating Printing Data Using a Spot Color for Special Colors".

* This function is available with VersaWoks Dual only. It is not available with VersaWoks.

You Cannot Generate Special Color Plates for the Following Types of Printing Data.

• Raster format

• Replacement data for variable data printing

• All of [RDG_WHITE], [RDG_GLOSS], and [RDG_PRIMER] are used (when one or two of [RDG_WHITE], 
[RDG_GLOSS], and [RDG_PRIMER] are used, special color plates can be generated for unused color(s) only).

MEMO

• For the printing data in which any of [RDG_WHITE], [RDG_GLOSS], and [RDG_PRIMER] is used, the following 
icons are displayed for [Special Items] under [Document Information] in the VersaWorks preview window.

 ¾ : RDG_WHITE

 ¾ : RDG_GLOSS

 ¾ : RDG_PRIMER
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More Advanced Printing Settings

Procedure

A In the “Job List,” double-click the job for which you want to generate special color plates.
The [Job Settings] window appears.

IMPORTANT

Special color plates are generated in the “Job Settings” window. They cannot be generated in the [Queue 
Properties] window.

B Configure the printing settings for special color printing.
Make the settings for printing white, gloss, and primer data in the "Job Settings" window. The setting 
items are the same as those specified in the "Queue Properties" window.
 " P. 18, "Printing Using White Ink"
 " P. 24, "Printing Using Gloss Ink"
 " P. 42, "Printing Using Primer"

C Click .

D Select [Generate Special Color Plate].

E Select [Generated Pattern].

Original image Print area Outside print area Entire image

The plate is generated 
below the objects.

The plate is generated 
in locations where no 
objects are present.

The plate is generated 
for the entire job size.

F Click [OK] to close the [Job Settings] window.

This is the end of the print job setting. To start printing, proceed to P. 46, "Starting the Print Operation".
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Correcting the Position of Special Color Plates
This section explains how to correct the printing position of special plates that have become misaligned, as 
shown below.

1 Media
2 Process color
3 Special color

* This function is available with VersaWoks Dual only. It is not available with VersaWoks.

1. Perform a test print.

A Double-click .
The [Queue A Properties] window appears.

MEMO

You can make the same settings also in the [Job Settings] window that is displayed when you double-click 
printing data in the “Job List.”

B Configure the printing settings for special color printing.
Make the settings for printing white, gloss, and primer data in the "Job Settings" window. The setting 
items are the same as those specified in the "Queue Properties" window.
 " P. 18, "Printing Using White Ink"
 " P. 24, "Printing Using Gloss Ink"
 " P. 42, "Printing Using Primer"

C Click .

D Use the [Special Color] list box under [Special Color Plate Correction] to select the 
special color ink to correct.

E Click [Test Print] for [Position Correction].
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F Select the [Pattern Settings], and click [OK].
• Simple: Select this to make rough adjustments to position misalignments.
• Detailed: Select this to make detailed adjustments to position misalignments.

A test pattern is printed.

2. Set the correction value.

A Enter the [Horizontal] and [Vertical] correction values.
Select the value on the printed test pattern that results in the least misalignment between A (refer-
ence line: black line) and B (special color line). Enter the C values (which represent the [Horizontal] 
and [Vertical] correction values) written on the test pattern. 

* The test pattern correction values differ for each piece of data. Set the correction values for each 
piece of data.

+1

B

C

A
A:Reference line (black line)
B:Special color line
C:Correction value

Correction Position and Printing Position in the Horizontal Direction

+3

＋ －
+2 +1 0 －1 －2 －3
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Correction Position and Printing Position in the Vertical Direction

+3

＋ －
+2 +1 0 －1 －2 －3

B Click [OK]. 

If you have to adjust the size of the special color printing data, proceed to P. 62, "Correcting the 
Size of Special Color Plates". 

Correcting the Size of Special Color Plates
This section explains how to adjust special plates with sizes that have shifted, as shown below. To correct the 
size, we recommend correcting the position first.

1 Media
2 Process color
3 Special color

* This function is available with VersaWoks Dual only. It is not available with VersaWoks.

1. Perform a test print.

A Double-click .
The [Queue A Properties] window appears.

MEMO

You can make the same settings also in the [Job Settings] window that is displayed when you double-click 
printing data in the “Job List.”
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B Configure the printing settings for special color printing.
Make the settings for printing white, gloss, and primer data in the "Job Settings" window. The setting 
items are the same as those specified in the "Queue Properties" window.
 " P. 18, "Printing Using White Ink"
 " P. 24, "Printing Using Gloss Ink"
 " P. 42, "Printing Using Primer"

C Click .

D Use the [Special Color] list box under [Special Color Plate Correction] to select the 
special color ink to correct.

E Click [Test Print] for [Size Correction].

F Select the [Pattern Settings], and click [OK].
• Simple: Select this to make rough adjustments to position misalignments.
• Detailed: Select this to make detailed adjustments to position misalignments.

A test pattern is printed.
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2. Set the correction value.

A Enter the [Size] correction value.
Select the value on the printed test pattern that results in the least misalignment between A (refer-
ence line: black line) and B (special color line). Enter the C values (which represent the [Horizontal] 
and [Vertical] correction values) written on the test pattern.
 * The test pattern correction values differ for each piece of data. Set the correction values for each 
piece of data.

A:Reference line (black line)
B:Special color line
C:Correction value

B

+1 C

A

Correction Value and Printing Position

+3 +2 +1 0 －1 －2 －3

＋ －

B Click [OK].
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